
CHAPTER

ONE

INSTALLATION

This chapter provides detailed instructions for installing FLOW-3D , configuring software licensing, and setting up the remote
solving features. For any trouble during the installation, please contact our support department at support@flow3d.com or by
calling (505) 982-0088 and we will be happy to assist.

1.1 Computer Setup

1.1.1 Supported Operating Systems

There are certain operating systems on which FLOW-3D and FlowSight are tested. While it may be possible to install and run
these programs on other operating systems, Flow Science supports and provides installation assistance for only the following
64 bit operating systems:

• Microsoft Windows 7 SP1 and greater

• Microsoft Windows Server 2008 R2 SP1 and greater

• Red Hat Enterprise Linux 7 and greater

• SUSE Linux Enterprise 12 (Remote Solving is not available on this platform)

Note:

• Other Linux distributions (e.g. Fedora, Scientific Linux, Debian, Ubuntu) may be compatible, but are not supported.

1.1.2 Hardware Requirements and Recommendations

Some general recommendations on hardware selection for running FLOW-3D are listed below.

• Processor: An x86-64 compatible CPU is required. Multiple core CPUs, particularly Intel Core i7, Intel Core i9, and
Intel Xeon, are strongly recommended. AMD Ryzen and Epyc CPUs are compatible.

• Memory: The software requires a minimum of 2GB RAM per processor core; 4GB per core is recommended. Note
that the amount of RAM required is highly problem dependent. For simulations with large domains, or with complex
geometry requiring fine resolution, significantly more RAM than the minimum requirement will be necessary.

Note: At least 64GB of RAM, and preferably 128GB, is highly useful for post-processing with FlowSight.

• Hard drive: Fast, high-capacity hard drives are recommended. SSD drives improve performance.

– The Windows installation requires at least 2.2GB of free disk space.
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– The Linux installation requires least 2.5GB of free disk space.

– Additional space is required for simulation results which are commonly on the order of 10GB in size, though
exceptionally large results files can be larger than 1TB.

• Graphics: nVidia Quadro cards are highly recommended, and are required for Windows machines which will be
accessed remotely. nVidia’s GTX series has shown decent performance on desktop and notebook machines but is not
recommended for remote visualization.

Warning: Certain graphics implementations are blacklisted and will result in degraded graphics and/or unreliable
performance. The following OpenGL renderers are neither recommended nor supported:

– Intel integrated graphics

– GDI Generic: This is the Windows default renderer when FLOW-3D is opened via Remote Desktop
Connection.

– Mesa: This is a common default implementation for Linux machines.

– Gallium: This is a common default implementation for Linux machines.

Note: We are aware of an issue with some Dell workstations where Dell’s backup application conflicts with the Qt toolkit Flow
Science uses to build its user interface. The bug is confirmed on your system if you go to the File menu, select Add Existing
Simulation and the GUI crashes. The resolution is described in the notification on the FLOW-3D User’s Site here.

1.1.3 Virtual machines

While FLOW-3D can be used on virtual machines, such as VMWare Workstation, Microsoft Hyper-V, VMWare
ESXi, and Oracle VirtualBox, there are varying levels of functionality available with these platforms.

• The FlexLM license server runs well on virtual machines. When using a dongle, it is necessary to pass USB through
from the physical machine to the virtual machine.

• The FLOW-3D CFD solver may be run on virtual platforms from the command line. Scripts and tools are included in
the software distribution for command line solver use. However, performance will be lower than when running directly
on the hardware.

• Due to graphics limitations on virtual machines, the graphical user interface will lose some functionality and may perform
poorly or not at all.

• Similarly, the FlowSight post-processor will lose some functionality and may either perform poorly or not at all.

1.1.4 Remote Visualization for Setup and Post-processing

It is increasingly common to use graphical programs on remote hardware. This is usually done for simulation setup using the
FLOW-3D graphical user interface and for post-processing simulation results using either the Analyze tab in FLOW-3D or the
dedicated FlowSight post-processor. Doing so requires certain combinations of hardware and software.

Windows computers include built-in remote visualization tools; these include a terminal services server, a special protocol for
connections, and a client commonly known as Remote Desktop. These tools can be used when connecting a Windows host
machine to a Windows client. Please see Remote Desktop for hardware and software recommendations.

Our recommendations when using a Linux host machine are to use an nVidia Quadro graphics card which supports the
newest available proprietary nVidia driver and Nice Software DCV. This software consists of a server that runs on the
host machine and a modified RealVNC client that runs on the guest machine. OpenGL is rendered on the host machine’s
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physical hardware. Nice Software DCV performs well on low-bandwidth network connections, such as a VPN. Penguin
Computing’s Scyld Cloud Workstation software is another option for remote visualization on Linux systems.

Warning:

• The free software VirtualGL suite is known to have display issues.

• Intel integrated graphics and motherboard graphics cards will perform poorly or not at all for remote visualization.

1.1.5 Settings

There are a few basic configuration settings that should be followed with FLOW-3D :

• It is strongly recommended that all input files be stored in a local directory on the machine instead of a network location.
The solver will run faster, the GUI will be more responsive, and the possibility of a network problem interfering with a
running simulation is eliminated.

• Ensure that the power settings for the machine are set so that it does not sleep, hibernate, or turn off after some period of
inactivity. Failure to do this can result in the computer sleeping (or hibernating, etc.) during long simulations.

• Where possible, it is recommended that Windows updates be configured to be installed after checking with the user.
This will prevent update-related reboots while simulations are running.

• Using automatic file compression utilities is not recommended.

Additionally, there are some optional configuration settings that can affect the performance of the solver for certain problems
and hardware configurations. There is no guarantee that these will make the solver run faster and they could make it run slower,
so use them with caution. Due to the unreliable effect on performance these optional settings are considered compatible but are
not supported.

• The KMP_AFFINITY environment variable gives users access to Intel’s Thread Affinity Interface, which controls how
OpenMP threads are bound to physical processors. Setting this variable to scatter can sometimes improves the
performance of the solver.

• Disabling Intel Hyper-threading can sometimes improve the solver performance. Similarly, limiting the number of pro-
cessors used by the solver to the number of physical processors on the machine can help when Hyper-threading is enabled.

1.2 Licensing Information

1.2.1 Licensing Requirements

Please ensure that you have a valid FLOW-3D license file or the name or IP address of your FLOW-3D license server
before beginning the installation. If you do not have a license file or a license server please contact a sales engineer or li-
censes@flow3d.com and provide the following information:

• The host name of the machine that will run the license server software

• Either the FlexID (if using a hardware dongle; the FlexID is printed on the side of the dongle) or the MAC address of the
machine

If the MAC address is not known:

• On Windows operating systems, the host name and MAC address can be found by opening the command prompt and
entering ipconfig /all. When multiple network interfaces are present, multiple MAC addresses may be listed in
the output. The connected ethernet device or the first in the series is preferable. Virtual adapter addresses should not be
chosen.
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• On Linux operating systems, typing /sbin/ifconfig in a terminal window will provide the MAC address, under
the heading HWAddr. The host name can be found by entering the hostname command in a terminal window. When
multiple network interfaces are present, multiple MAC addresses may be listed in the output. eth0 is usually best, but
if you are unsure which MAC address to use, please send a text file or attach a screen capture with the output of the
command, and the License Administrator will determine the best option.

Once the host name and MAC address or FLEXID have been received, the License Administrator at Flow Science will send
the license file (flow3d.lic) as an email attachment. It is an ASCII text file with encryption codes that allow it to be used
only on the computer or dongle for which it was generated. Check the license file to be sure that it contains the host name and
HOSTID that matches the license server. More information about licensing can be found in the following sections on FlexNet
License Administration Tools and Licensing Terminology.

1.2.2 FlexNet License Administration Tools

FLOW-3D uses the licensing package FlexNet Publisher, by Flexera Software. FlexNet enables FLOW-3D licenses to be
shared across a network.

Flexera Software provides utilities for users or local license administrators to manage FlexNet licensing activities. The FlexNet
End User Manual is available in the utilities subdirectory of the FLOW-3D installation in both PDF and HTML formats.
For Windows computers, the program lmtools.exe is provided with all installations. With LMTOOLS, users can start, stop
and configure FlexNet license servers, get system information, get server information, and more. For more information, please
see Chapter 12 of FlexNet End User Manual.

On Windows computers, the license manager daemon lmgrdwill restart automatically whenever the computer is rebooted. On
Linux computers, however, the license manager must be started each time the computer is rebooted. To have the license manager
start automatically on Linux requires editing the appropriate boot script and inserting the appropriate startup commands. See
Section 6.2 of the FlexNet End User Manual for more information. A summary of commonly used administration tools on
Linux is included here. Full descriptions of these and other available utilities can be found in Chapter 12 of the FlexNet
manual.

• lmdiag - diagnoses license checkout problems Useful debugging command: lmutil lmdiag -n -c
"full_license_file_path"

• lmdown - gracefully shuts down all license daemons on the license server node.

• lmgrd - the main daemon program for FlexNet

• lmhostid - reports the HOSTID of a system

• lmreread - causes the license daemon to reread the license file and start any new vendor daemons

• lmstat - helps monitor the status of all network licensing activities Useful debugging command: lmutil lmstat -a
-c "full_license_file_path"

• lmver - reports the FlexNet version of a library or binary file

Note:

• Using kill -9 to to shut down the license server on Linux computers is not recommended. Instead, use either lmdown
or use the kill command without the “-9” parameter.

• The lmgrd license server is now supported on Red Hat Enterprise Linux 7

1.2.3 Licensing Terminology

• Definition of Client and License Server: Any computer running FLOW-3D is referred to as a “client.” The computer
on which the FlexNet license server is installed will be referred to as the “license server.” The client and server may be
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(and often are) the same machine.

• Software Package and Software Distribution: The terms “software package” and “software distribution” will be used
to refer to the directory structure containing all of the data files and executables needed to run FLOW-3D on a particular
computer.

• License Files and Servers: A valid license file from Flow Science is required to use FLOW-3D . This license file will be
sent as an email attachment from Flow Science’s License Administrator at licenses@flow3d.com. This license file must
be saved in the licenses directory of the FLOW-3D installation on the machine that will act as the license server. More
detail about this is given in the Windows Installation and Linux Installation sections below.

As discussed in Floating vs. Node-Locked Licenses, FLOW-3D can be used on multiple computers, but one computer
must be selected to be the license server. If the computer chosen to be the license server will not actually be used to run
FLOW-3D , then only the FlexNet license server needs to be installed on that machine. Most often, a licensing dongle
that attaches to the USB port of the computer will be provided by Flow Science.

1.2.3.1 Tokens

The total number of FLOW-3D solver processes that can be run concurrently is determined by the number of “tokens” contained
in the license file. The number of tokens available depends on how many were purchased. The license server checks tokens out
to client computers on the network, and then checks them back in when the application has completed. In this process, tokens
are counted by the license server and when all of the tokens purchased have been checked out, no more tokens can be checked
out until a token which is in use has been checked in.

There are several different types of solver tokens. The most important distinction is between “serial” solver tokens and “parallel”
solver tokens. Flow Science offers multi-processor versions of FLOW-3D for both shared-memory (SMP) and distributed-
memory (cluster) environments. A shared memory parallel solver token enables FLOW-3D simulations to use more than one
processor on a multiprocessor computer.

The total number of FLOW-3D solver processes that can be run concurrently is determined by the number of “instance tokens”
contained in the license file. Along with the instance tokens, core tokens are also checked out to enable that particular instance
of the solver to run on multiple CPU cores. It is the combination of an instance token plus core tokens that enables a simulation
to run.

The license server checks tokens out to client computers on the network, and then checks them back in when the application
has completed. In this process, tokens are counted by the license server and when all of the tokens have been checked out, no
more tokens can be checked out until a token which is in use has been checked in.

There are essentially an unlimited number of tokens available to run FLOW-3D ’s auxiliary programs such as the preprocessor,
the postprocessor, and the various visualization options. The exception is for FlowSight, where two flowsight tokens are
provided for each FLOW-3D instance token.

1.2.3.2 Floating vs. Node-Locked Licenses

There are two general types of licenses used to enable FLOW-3D : “floating” and “node-locked.” A floating license is the most
common type of license and is available to any computer on the network. Flow Science can also provide a node-locked license.
Node-locked licenses can only be used on the designated computer.

Both floating and node-locked licensing schemes require that one computer be designated as the license server.

• Floating Licenses: To use floating licenses, it is important that both the network and the computer intended for use as
the license server are reliable. The TCP/IP protocol must be loaded and functional, and all intended clients must be able
to access the license server. Floating licenses may also be accessed through a VPN tunnel. The computer that is acting
as the license server may be any computer on the network, and does not need to have FLOW-3D installed. The license
server may be a Windows or a Linux computer. Users may load FLOW-3D on any client running a supported Linux
or Windows computer on the network. A hardware key is not needed on a client computer unless it uses a node-locked
license.
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To employ a floating license on a single computer, FLOW-3D should be installed with the client/server option. The
license server and the clients may reside on the same local area network, over a WAN, or across VPN. FLOW-3D must
be installed locally on each client. An example of a floating license configuration is shown below.

• Node-Locked Licenses: Users may choose to have their solver tokens locked to a particular computer so that only that
computer can run the solver.

Both floating and node-locked licensing schemes have their advantages and disadvantages. A floating license is advised if
several people are sharing a license, or it may be necessary to run FLOW-3D on a different computer if a particular computer
is busy. With a floating license, a problem can be set up on one computer while using another to run the FLOW-3D solver on
a second problem. If other machines or problems are using all available tokens, the solver will not run until a token becomes
available. The main advantage of a node-locked license is the ability to ensure that token(s) are always available to a specific
machine and not available to others on the network.

Note: All licenses are floating licenses unless specifically requested as node-locked.

1.2.3.3 License Token Checkout Order

When FLOW-3D attempts to check out a license token, FLEXlm finds the server by trying the following (in order):

1. Environment variable F3DTKNUX_LICENSE_FILE

2. Registry value F3DTKNUX_LICENSE_FILE (Windows operating systems)

3. Reads the license file directly (%F3D_HOME%\licenses\flow3d.lic)

FLOW-3D is looking for the server, not necessarily the file. If the server is found, the local license file may not be read.
However, if the server is not found, the license file is read as follows:

1. The SERVER line is read to find the location of the server.

2. The VENDOR line is read to find the name of the vendor daemon.
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3. If the third line is USE SERVER, the rest of the file is skipped and the server is contacted directly.

USE SERVER is recommended as it improves performance when a license server is used. It also avoids a problem that may
occur, where the license server is updated but local license files are not updated.

1.3 Procedure

1.3.1 Windows Installation

1.3.1.1 Standard Installation

Note:

• Administrator privileges are necessary to install FLOW-3D on Windows. Before installing, please close all other
running programs.

• If installing on Windows 8, please consult Windows 8 and 8.1.

• Third-party security software or firewalls, such as Norton 360, may interfere with license checkout and/or remote
server operation. When using such software, temporarily disabling it and testing the license checkout is recommended.
If the security software appears to be the issue, please consult the software vendor for the correct procedure to allow
lmgrd.exe and F3DTKNUX.exe access through the firewall, or open the ports needed for proper operation. These
ports are listed in the licensing documentation below.

• If installing on a machine that has an earlier FLOW-3D version installed, please close any running copies of
RunnerServer.exe. This can be done by either:

– Right-clicking the icon in the system tray, choosing Open, and choosing Terminate.

– Opening the Windows Task Manager and stopping any RunnerServer.exe processes shown in the Pro-
cesses tab. It may be necessary to click the Show Processes from All Users button to find the RunnerServer.exe
process.

The installation can be started by double clicking the downloaded flow3d_v12.0.exe file.

1. On Windows operating systems, a User Account Control dialog, similar to the one below, will appear. The “Verified
publisher” entry should confirm that the executable has been digitally signed by Flow Science, Inc.
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2. Next, the Preparing to Install dialog will be displayed. It requires no user input and will disappear after several seconds.

3. The next dialog to appear is the Welcome screen. Click Next to continue.
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4. The next dialog is the FLOW-3D end user license agreement. Please read it carefully. If all the terms are acceptable,
click the Next button to signify agreement and move to the next dialog.

5. Now the install location can be chosen. The default directory can be used, or FLOW-3D can be installed to a specific
directory. Once the location is chosen, click Next.
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Note: When installing to a location other than the default, it is important that the directory name not contain spaces,
ampersand or other special characters, or multiple dots.

6. The available features are shown. Individual features may be selected for installation by checking the appropriate box. If
this machine will connect to a remote license server, License Server should be unchecked. This is equivalent to the Client
Only installation in older FLOW-3D versions.
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Note:

• The License Server option is selected by default.

• For this version, it is necessary to install the new license server. This version requires the new license server
executable F3DTKNUX.exe. This server is backward-compatible with prior versions of FLOW-3D .

• If this machine is intended to act as a remote server with the Remote Solving feature (see Remote Solving Setup),
FLOW-3D should be checked.

7. If the License Server option was not selected, this dialog will be shown. It allows an IPv4 address, a server name, or a
port@host to be specified for the license server. If unknown, the IP address can be found by opening the command prompt
and entering ipconfig /all on the license server machine. The name can be determined by opening a command
prompt or terminal window and issuing the command hostname.

Note: When using a hostname, the server should respond to ping requests. The name required may differ based on
the network. For example, a machine may respond to ping host.company.com but not to ping host. If this is
the case, the full name must be used. If the hostname entered is not reachable, the client will not be able to check out a
license.
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8. Also, if the License Server option was not selected, this reminder will be shown. The newest license server is required;
old license server versions from other products will not work. The new license server is backward compatible with older
software versions, so installing the new server does not affect the ability to run previous versions.

9. The next dialog is only shown if the FLOW-3D feature is being installed. It allows the RSS feed connection to be
bypassed. Leaving the box unchecked allows the FLOW-3D user interface to make an encrypted TLS connection to
the FLOW-3D website, displaying news and information useful to users. Opting out by checking the box disables this
functionality. This secure, encrypted connection may contravene local laws.
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10. FLOW-3D is now ready to install.

11. The FLOW-3D installer will copy the necessary files.
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12. If the license server is being installed, FLOW-3D will ask to temporarily shut down any existing license servers. This
allows the FLOW-3D license as well as FlexLM licenses from other vendors to be served. This can only be skipped
safely when no other software that uses FlexLM licensing is installed, including older versions of FLOW-3D .

13. Also, if the license server component is being installed, the drivers for the USB dongle will be installed.

14. Next, the installer will create firewall exceptions to allow communication to remote license servers and for remote solving.

15. Finally, the Microsoft Visual C++ redistributables will be installed.
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16. The installation is now complete.

17. After installation, an opportunity is presented to learn about new features in this version.

18. The FLOW-3D and FlowSight (if installed) icons will now appear on the desktop.

1.3. Procedure 16



FLOW-3D User Manual, Release 1.0.0

19. Also, there will be a new Program Group in the Windows Start Menu. It includes tools and viewers appropriate to the
features that were installed.

1.3.1.2 Special considerations

Windows 8 and 8.1

Flow Science highly recommends updating Windows 8 to version 8.1 Update 1 (or the newest version available) before
installing FLOW-3D .

• On all versions of the Windows 8 operating system, including those which have been updated, the following consider-
ations apply:

– Secure boot must be temporarily disabled for the Sentinel HASP USB drivers to install. Please see http://technet.
microsoft.com/en-us/library/dn481258.aspx for the procedure.

– The “Creating Firewall Exceptions” dialog may not be shown. However, the firewall exceptions are created.

• When the Windows 8 operating system has not been updated, the desktop icons are not created by the installer auto-
matically.

– One potential solution is to install a third-party Start Menu replacement, such as Classic Shell or Start8.
If a Start Menu replacement is installed prior to installing FLOW-3D , the icons will be created correctly.

– Another option is to use the Modern interface All Apps view. This can be done by:

1. Right-clicking the Start Screen, then clicking All Apps at the lower right.
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2. There will be a Program Group for FLOW-3D .

3. Right-click one of the icons and choose Pin to Start at the lower left to place the icon on the main Start Screen.

4. The icon should now appear on the main Start Screen and can be used to launch the program.

Remote Desktop

Flow Science highly recommends nVidia Quadro K, M, or P series graphics hardware with nVidia driver version 341.05 or
newer. With this combination of card and driver, remote desktop connections automatically run on the native hardware with
full 3D acceleration.

When connecting to a remote desktop session, Windows uses software rendering unless an nVidia Quadro graphics card is
installed. This impacts performance negatively for both FLOW-3D and FlowSight. To determine whether FLOW-3D is using
software rendering, choose About from the FLOW-3D Help menu. The entry for GL_RENDERER will show GDI Generic if
software rendering is being used.

If software rendering is being used, there are several options to enable hardware rendering. One easy option is to start FLOW-
3D from the physical console, then connect the remote desktop session. Some VNC software, such as Nice Software DCV,
uses hardware rendering by default. Finally, the TSCON command can be added to the batch file used to launch FLOW-3D to
temporarily pass control back to the console session.

To use TSCON, determine which session is connected. This can be determined using a query. Click the Start button and type
cmd in the box labeled Search programs and files. Click cmd.exe when it appears at the top of this window to
open a command prompt.

1.3. Procedure 18



FLOW-3D User Manual, Release 1.0.0

At the prompt, type query session to receive a list of sessions. The relevant remote desktop session will be listed with a
greater than symbol to its left and show the username with which you logged in. In this example, user dev is connected with a
session ID of 1.
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To connect session 1 (for example) to the console, add tscon 1 /dest:console to the beginning of the FLOW-3D
launch batch file (replace 1 with your session ID). To edit the batch file, right-click the FLOW-3D desktop icon and choose
Edit or navigate to %F3D_HOME%\local, right- click flow3d.bat and choose Edit. In the resulting notepad window,
the line can be added. It should be placed before all other lines in the file.

After editing the file, save it and launch FLOW-3D . The remote desktop session will be ended, and when reconnected, the
hardware renderer should now be shown in the About menu.

There are a few potential problems with this approach:

1. The TSCON command must be run as administrator. If Error 5 occurs, right-click the FLOW-3D desktop icon and
choose Run as Administrator.

2. The host machine must have a supported graphics card. See Hardware Requirements and Recommendations

3. Due to the graphics hardware requirement, this will not work for virtual machines.

4. The user must have an open console session. This may not work after a reboot and is known not to work when
another user is logged into the console session.
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Multi-User Machines

Windows Server or Linux operating systems are recommended if it is desired that multiple users be able to run FLOW-3D
simulations simultaneously.

1.3.2 Linux Installation

1.3.2.1 Standard Installation

FLOW-3D for Linux is distributed as a gzip-compressed tar archive. The installation files can be extracted from
flow3d_v12.0.tar.gz in a terminal window, using the command tar -xzvf flow3d_v12.0.tar.gz. The tar
archive can be unpacked into any directory on the file system using the -C flag. For example, to extract the archive to /home/user,
use tar -xzvf flow3d_v12.0.tar.gz -C /home/user.

cd to the directory where the installation files exist, or to which they have been unpacked, and run the script ./
install-flow3d.sh. A preceding dotslash may be necessary depending on whether the current directory is on the system
PATH (e.g., ./install-flow3d.sh). By default, this file is executable. FLOW-3D is only supported on 64-bit Red Hat
Enterprise Linux 7 or greater or SUSE 12. It may be possible to install on other distributions, but due to potential library and
package differences, Flow Science does not provide technical assistance on these distributions.

Note:

• The FlowSight visualization software requires libstdc++.so.5. This may be installed on RHEL6 or RHEL7 using
the command yum install compat-libstdc++-33. Installing this package on SUSE12 requires that the 64-bit
Legacy Module 12 be enabled. This requires logging into the SUSE customer center and enabling the repository, or
downloading the module directly. After the module is enabled, install the library using zypper in libstdc++33.

• The installation script must be run as root

• The default installation directory is /opt/flow3d/v12.0

1. Having the Linux Standard Base package installed allows the script to work best. It is also needed by the FLOW-3D
RPM. This can be installed using the commands below.

• RHEL6: yum install lsb

• RHEL7: yum install redhat-lsb

• SUSE12: zypper in lsb-release

2. Execute the install script in the directory where the tarball was unpacked. For example, if viewing that directory, use the
command ./install-flow3d.sh. The license agreement can be read prior to installing the software.
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3. If all the terms are acceptable, typing y or yes and pressing Enter will continue the installation.

4. FLOW-3D can be installed to a directory of your choosing. The default is /opt/flow3d/v12.0. Press Enter to use
the default. To change the installation directory, enter a PATH here and press Enter.
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Note: This is the full PATH where the installation will be placed. For example, if the PATH /opt were chosen, the
FLOW-3D installation would be installed directly to /opt.

5. After the directory has been determined, an installation type may be chosen.

Note: If this machine is intended to act as a remote server with the Remote Solving feature (see Remote Solving Setup),
an installation type that includes FLOW-3D should be chosen.
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6. If an installation type including FLOW-3D was chosen, the next question allows the RSS feed connection to be bypassed.
Leaving the box unchecked allows the FLOW-3D user interface to make an encrypted TLS connection to the FLOW-3D
website, displaying news and information useful to users. To disable this functionality, answer ‘y’ or ‘yes’ to opt out.
This secure, encrypted connection may contravene local laws.

7. Next, the script will display an installation summary, and request the name or IPv4 address of the license server. This
server machine must be accessible by the client. Unless networking is configured otherwise, ping hostname or ping
(ip_address) will verify whether the machine can be reached.

Note: If a license server will be installed locally on this machine use 127.0.0.1

8. The installation script will now install the RPMs that are needed for the selected Installation Type. It will also write all
the scripts needed to run the installed software.
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9. Next, users can be set up for Remote Solving. Choosing a user here writes a script for sysVinit or systemd to run at boot
time for the selected user. This script restarts the Remote Solving daemon process when the computer is rebooted. If this
behavior is not needed, this option is not necessary.

10. Finally, the install script allows the creation of desktop icons for root and/or users. Icons may be created for a list of
users. List the users with a space between each username, as in the example.
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11. The installation will now complete.

Shell scripts, named flow3dvars.sh and flow3dvars.csh, have been written into the local directory of the
installation path. The install script will write the full path to these files to both stdout and the install.log file. If
FlowSight was chosen, FlowSight.sh and FlowSight.csh have been written in the local directory. Again, the
script will give full information.

Necessary libraries are included with the distribution in the $F3D_HOME/gui/lib directory. The
LD_LIBRARY_PATH environment variable is set in the flow3dvars scripts so any libraries not found on the sys-
tem will be accessible.

The install script also shows the source command that can be used to set up an environment to run FLOW-3D . The
command may be added to the user’s .bashrc or .cshrc file, if desired. FLOW-3D can then be run from a terminal
prompt using the command flow3d&. Alternately, FLOW-3D may be launched using the shell script in the local
directory, or using the desktop icon (if created).
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12. After installation, the installation directory will contain a directory structure similar to the one shown. A log of the
installation, named install.log will be at the top level, and the scripts created by the installer will be in the local
directory.

Note: On SUSE12, the installer will remove the Remote Solving functionality automatically.
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13. The flow3dvars.sh file illustrates the environment variables that should be set to successfully run FLOW-3D . After
using the source command, use the command flow3d to run FLOW-3D .
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1.3.2.2 Linux License Server: lmgrd

Installation

For FLOW-3D , the lmgrd license server and the F3DTKNUX vendor daemon are compatible with Consistent Network Device
Naming as introduced in Red Hat Enterprise Linux 7. There are important security fixes in the versions included and it is highly
recommended to use them.

Warning: Older versions of lmgrd and F3DTKNUX are NOT compatible with this version, while older FLOW-3D
versions DO work with the new license server executables.

Note: The lmadmin license server is no longer included for Linux.
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1. The necessary executables are included at $F3D_HOME/licenses, where $F3D_HOME is the PATH chosen during in-
stallation. By default, $F3D_HOME is /opt/flow3d/v12.0

2. Open the necessary firewall ports for the license server. lmgrd uses TCP ports 27000 through 27009 by default, but this
is configurable by editing the license file. Whatever port you choose, open that port and the next nine. So, for example,
if you choose port 28000, open ports 28000 through 28009. Typically, Red Hat 6 uses iptables, while Red Hat 7 and
SUSE 12 use firewalld. The commands to open ports differ between these firewalls.

iptables: iptables -A INPUT -p tcp --dport 27000:27009 -j ACCEPT

firewalld: firewall-cmd --permanent --add-port=27000-27009/tcp

3. Open the necessary firewall ports for the F3DTKNUX vendor daemon. It only needs a single port, which can be determined
by starting the license server and checking the log file, or by adding a line to the license file as the second line (under the
first line, which starts with SERVER). The default port is 49183 – it can be added using the same command as above.

SERVER (server_name_or_ip) (flexid or host id) (optional port setting for lmgrd as a number)

VENDOR F3DTKNUX port=49183

So, for example, to run lmgrd on ports 28000 through 28009, and F3DTKNUX on port 49183:

SERVER licenses.flow3d.com FLEXID=9-12345678 28000

VENDOR F3DTKNUX port=49183

4. After opening the ports, restart the firewall service or reload the configuration to apply changes.

service iptables restart

firewall-cmd --reload

5. It is recommended to run the license server as a user, rather than as root. The location of the log file should be a PATH
where this user may write. Here is the command to start the server:

/path/to/flow3d/licenses/lmgrd -c /path/to/flow3d.lic -l /path/to/log/file.log

For example, with the defaults:

/opt/flow3d/v12.0/licenses/lmgrd -c /opt/flow3d/v12.0/licenses/flow3d/lic -l
/home/(username)/flow3d.log

6. The log file may then be examined to determine that the server started correctly, or, if there any problems, what the
problems may be.

HASP USB dongle driver

Sentinel has released a HASP USB dongle driver that is compatible with all supported Linux distributions. Linux users may
now receive a USB dongle. When this occurs, the driver should be installed.

Note: This driver should be installed before the license server is started.

The driver is included in the FLOW-3D installation archive in the HASP_driver directory. Change to this directory using
the cd command.
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The HASP driver includes 32-bit executables and libraries, and requires a 32-bit glibc package. This can be installed using the
command yum install glibc.i686

No other dependencies should be needed. This can be verified by using the command rpm -qpR aksusbd-2.5-1.i386.
rpm
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Assuming all dependencies are installed, the package may be installed using rpm -i aksusbd-2.5-1.i386.rpm

Finally, the HASP library libhasp_linux_x86_64.so should be copied to /usr/lib, using cp
libhasp_linux_x86_64.so /usr/lib
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The HASP USB driver is now installed and the dongle may be connected. Verify that the light turns on on the USB dongle.

FLOW-3D and TruVOF are registered trademarks in the USA and other countries.
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2.1 Moving License Servers

When a floating license is locked to a fixed host ID, such as an Ethernet address or host ID, it is recommended that users choose
a server which is likely to be used for the duration of the license. Changing license servers can be done once a year without
incurring a re-licensing fee. Re-licensing fees are not necessary (maximum one change per year) when users use a USB or
parallel port hardware key (dongle) as their host ID. To move the dongle (and hence license server) to a different computer, the
user may change the first line in the license file to reflect the computer name change. For example, if the license server was
previously running on a server named Celsius and will be moved to Kelvin, the first line in the license file would be changed
from SERVER Celsius FLEXID= "your ID" to SERVER Kelvin FLEXID= "your ID".

2.2 Installing a New/Replacement License File

2.2.1 Windows

1. When a new or replacement flow3d.lic is received from the License Administrator, place it into the licenses
subdirectory found within the directory where FLOW-3D or the license server were installed. The default location is
C:\flow3d\v12.0\licenses.

2. Start the LMTOOLS utility, either from this directory, by double-clicking, or by clicking the icon in the Start Menu.
Click the Start/Stop/Reread tab. Verify that the license file is in the correct location by checking the directory shown
(highlighted in the figure below). If correct, click the ReRead License File button (also highlighted).
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2.2.2 Linux

Note: Older lmadmin license servers are not compatible with this version.

1. Check whether the license server is running using ps aux | grep lmgrd. This will provide the PID of any running
license servers. They can be killed using kill (PID). It is not recommended to use kill -9 on a running lmgrd
process.

2. It is recommended to run the license server as a user, not as root. The command to start the new lmgrd process is
lmgrd -c flow3d.lic -l logfile.log, where the logfile name may be changed as needed. flow3d.log
is often used.

2.3 Troubleshooting License Problems

2.3.1 Windows

This guide provides a series of steps that can be used to diagnose and resolve licensing issues with FLOW-3D . Feel free to
contact our support staff at support@flow3d.com or at (505) 982-0088 if you have trouble at any point.

1. Close any open instances of FLOW-3D and close RunnerServer.exe (an application running in the task tray). After
closing FLOW-3D , confirm that there are no instances of flow3d.exe, hydr3d.exe, RunnerServer.exe, guiobs.exe, or
flscon.exe running by looking at the processes tab of the task manager. If there are, terminate the process.

2. Verify that the correct install option was chosen.

a. Client: You intend to run FLOW-3D on this computer but will install the license server on another computer.
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b. Server / Client: You intend to run both FLOW-3D and the license server on this computer.

c. Server: You are only installing the license server on this computer.

If the Server or Server/Client installation was not selected for the machine running the license server you will need to
run the Server installation on this computer. You can check if the necessary software was installed by looking for the
files F3DTKNUX.exe and lmgrd.exe in the licenses folder of the installation directory on the server machine. If they are
in this folder then the server software was installed.

3. Verify that the license file (flow3d.lic) is in the correct location. It should be in the licenses sub folder of the installation
directory on the server machine (e.g. C:\flow3d\v12.0\licenses).

4. Make sure you are using the correct license file for your server machine. You will need to open the license file (flow3d.lic)
in a text editor on the server machine.

a. Make sure the server machine computer name (or IP address) matches what is in the license file. This parameter
may be edited in the license file to match the computer.

i. The first line of the license file will read SERVER <name> ...

ii. The computer name, <name>, can be found from My Computer → Properties. Alternatively, the IP address
can be found by opening a command prompt and typing ipconfig -all. The IP address looks like: xx.
x.x.xxx.

b. If you were sent a USB dongle:

i. Verify that the dongle is plugged into the server machine and that the red light on the dongle is lit.

If the red light is not lit, please verify that the dongle is connected to a USB 2.0 port. USB 3.0 ports have blue
plastic in the connector.

If the dongle is connected to a USB 2.0 port and the light is not on, the HASP driver may not have installed
properly. Open Windows Explorer and navigate to %F3D_HOME%\licenses. Hold the SHIFT key and right-
click. Choose Open command window here from the context menu. Enter haspdinst -i and the driver
will be installed. The machine may need to be rebooted after the driver installation. The dongle should now be
lit.

ii. Make sure that the dongle matches the license file

1. Compare the flexID marked on the dongle with the one at the top of the license file (open in a text editor).
The first line of the license file should look like: SERVER <name> FLEXID=<flexID> <port> ,
where <flexID> is a string of numbers and characters and cannot be modified.The dongle flexID must
match what is specified in the license file.

2. This can also be checked by opening LMTOOLS, located in the licenses folder of the install directory, and
viewing the FLEXID box on the system settings tab.

c. If your license is locked to an Ethernet (MAC) address:

i. Make sure the server network card physical address matches what is specified in the license file. The value in
the license file cannot be changed.

1. The first line of the license file will read SERVER <name> <physical address> <port>

2. The server network card physical address, <physical address>, can be found by opening a com-
mand prompt and typing ipconfig -all. The server network card physical address looks like:
xx-xx-xx-xx-xx-xx

5. Check that the necessary environment variables are set on the client machines.

a. Right-click on the FLOW-3D icon and choose Edit.

b. Verify that the following variables have the correct values. Note that the values below are based on the default
install location.
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i. F3D_HOME = C:\flow3d\v12.0 (the FLOW-3D installation directory)

ii. PATH = C:\flow3d\v12.0\local

iii. F3DTKNUX_LICENSE_FILE = @xx.x.x.xxx (this should point to the server IP address preceded by the
@ symbol)

6. Verify that the firewall on the server machine has exceptions for the license daemons.

a. Go to Start → Control Panel → Windows Firewall.

b. Click Allow a program or feature through Windows Firewall.

c. Verify that FLOW-3D_v12_license_daemon and FLOW-3D_v12_vendor_daemon are in the list and checked for the
appropriate networks. If not, choose Allow another program. . . and browse to the licenses folder of the installation
directory and add exceptions for lmgrd.exe and F3DTKNUX.exe.

7. Now restart the license server and reread the license file on the server machine.

a. Open a command prompt and change to the licenses folder in the install directory (e.g. cd C:\flow3d\v12.
0\licenses)

b. Type lmutil lmdown -c flow3d.lic to shut down any running license daemons

c. Type lmgrd -c flow3d.lic -l flow3d.log to restart the server. You may be notified that the firewall is
blocking the license daemons. If this is the case, allow exceptions for F3DTKNUX.exe and lmgrd.exe

d. Perform a status check by typing lmutil lmstat -c flow3d.lic. This will display the server status. It
should now report:

[Detecting lmgrd processes...]
License server status: <port>@<name>
License file(s) on <name>: @<IPaddress>
License file(s) on <name>: <licensepath>: <name>: license server UP (MASTER) v11.13
Vendor daemon status (on <name>): F3DTKNUX: UP v11.13

Where <port> is the port number being used by the server, <name> is the name of the computer running the
server (as it appears on the network), <IPaddress> is the IP address of the server, and <licensepath> is
the full directory location of the license file (flow3d.lic). Note that running multiple license servers on the same
machine may result in conflicts in port usage. If there is a conflict, change (or add) the port number, <port>, in
the license file and repeat step 6. The default port number is 27000.

8. You should now be able to launch and run FLOW-3D .

2.3.2 Linux

This guide provides a series of steps that can be used to diagnose and resolve licensing issues with FLOW-3D . Feel free to
contact our support staff at support@flow3d.com or at (505) 982-0088 if you have trouble at any point.

1. Close any open instances of FLOW-3D and close RunnerServer.exe. It is. worth verifying that there are no instances of
flow3d.exe, RunnerServer.exe, hydr3d.exe, guiobs.exe, or flscon.exe running by typing ps -A | grep flow3d, ps
-A | grep hydr3d, etc. If something is running it can be stopped using the kill command.

2. Verify that the correct install option was chosen.

a. Client: You intend to run FLOW-3D on this computer but will install the license server on another computer.

b. Server / Client: You intend to run both FLOW-3D and the license server on this computer.

c. Server: You are only installing the license server on this computer.
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If the Server or Server/Client installation was not run on the machine running the license server you will need to run the
Server installation on this computer. You can check if the server software was installed by looking in the licenses folder
of the installation directory on the server machine for the files F3DTKNUX.exe and lmgrd.exe. If they are in this folder
then the server software was installed.

3. Verify that the license file (flow3d.lic) is in the correct location. It should be in the licenses sub folder of the installation
directory on the server machine (e.g. /opt/flow3d/v12.0/licenses).

4. Make sure you are using the correct license file for your server machine. You will need to open the license file (flow3d.lic)
in a text editor (or using more) on the server machine.

a. Make sure the server machine computer name (or IP address) matches what is in the license file. This parameter
may be edited in the license file to match the computer.

i. The first line of the license file will read SERVER <name> ...

ii. The IP address, <name>, can be found by entering /sbin/ifconfig in to a terminal. The eth0 section will
contain the information. The IP address is called inet addr and looks like: xx.x.x.xxx

b. If you were sent a USB dongle (RHEL only):

i. Verify that the dongle is plugged into the server machine and the red light on the dongle is lit.

ii. Make sure that the dongle matches the license file

1. The first line of the license file should look like: SERVER <name> FLEXID=<flexID> <port> ,
where <flexID> is a string of numbers and characters.

2. The flexID is marked on the dongle and at the top of the license file (open in a text editor). The dongle
flexID must match what is specified in the license file and the value in the license file cannot be modified.

3. This can also be checked by opening LMTOOLS, located in the licenses folder of the install directory, and
viewing the FLEXID box on the system settings tab

c. If your license is locked to an Ethernet (MAC) address:

i. Make sure the server network card physical address matches what is specified in the license file. The value in
the license file cannot be changed.

1. The first line of the license file will read SERVER <name> <physical address> <port>.

2. The server network card physical address, <physical address>, can be found by entering /sbin/
ifconfig into a terminal. The eth0 section will contain the information. The server network card
physical address is called HWaddr and looks like: xx-xx-xx-xx-xx-xx

5. Check that the necessary environment variables are set on the client machines. The easiest way to do this is to run one of
the included shell or c-shell files.

a. Open a terminal and change to the local directory in the install directory (e.g. cd /opt/flow3d/v12.0/local)

b. Type more flow3dvars.sh (or more flow3dvars.csh) and verify that the environment variables are
correct. The variables and example definitions are shown below. If the definitions are incorrect they can be fixed
using a text editor like vi.

i. export F3D_HOME = /opt/flow3d/v12.0: This should point to the FLOW-3D installation directory.

ii. export F3D_VERSION=double: Sets the default solver type to double-precision.

iii. export PATH=$F3D_HOME/local:$PATH: Tells the file system where to find the FLOW-3D executable

iv. ulimit -s unlimited: This unlimits the stack size. Not doing this is a common cause of segmentation
faults.

v. export F3D_HELP=/usr/bin/firefox (default browser for help files)

vi. export LD_LIBRARY_PATH=$LD_LIBRARY_PATH:$F3D_HOME/gui/lib
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vii. export LD_LIBRARY_PATH=$LD_LIBRARY_PATH:$F3D_HOME/gui/lib/qt

viii. export LD_LIBRARY_PATH=$LD_LIBRARY_PATH:$F3D_HOME/gui/lib/ifort

ix. export F3DTKNUX_LICENSE_FILE = @xx.xx.xx.xxx: This variable is used on client machines
and should point to the server name or IP address.

c. Type source flow3dvars.sh (or source flow3dvars.csh) to set the variables defined in the shell
(or c-shell). This command will need to be called every time a new terminal is opened to launch FLOW-3D .
Alternatively, this command can be added to the .bashrc file to make this an automatic process.

6. Now restart the license server and reread the license file on the server machine

a. Open a terminal and change to the licenses directory in the install directory (e.g. cd /opt/flow3d/v12.0/
licenses)

b. Type ./lmdown -c flow3d.lic to shut down the running license daemons

c. Type ./lmgrd -c flow3d.lic -l flow3d.log & to restart the server

i. The & is to run the daemons in the background

ii. You may need to allow firewall exceptions for F3DTKNUX.exe and lmgrd.exe

d. Type ./lmreread -c flow3d.lic to reread the license file

e. Perform a status check by typing ./lmstat -c flow3d.lic. This will display the server status. It should
now report:

[Detecting lmgrd processes...]
License server status: <port>@<name>
License file(s) on <name>: @<IPaddress>
License file(s) on <name>: <licensepath>: <name>: license server UP (MASTER) v11.13
Vendor daemon status (on <name>): F3DTKNUX: UP v11.13

Where <port> is the port number being used by the server, <name> is the name of the computer running the
server (as it appears on the network), <IPaddress> is the IP address of the server, and <licensepath> is the
full directory location of the license file (flow3d.lic).

f. Note that running multiple license servers on the same machine may result in conflicts in port usage. If there is a
conflict, change (or add) the port number, <port>, in the license file and repeat step 6. The default port number is
27000.

7. You should now be able to launch and run FLOW-3D .

FLOW-3D and TruVOF are registered trademarks in the USA and other countries.
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3.1 Remote Solving Setup

FLOW-3D can connect remote machines (called remote servers) to a primary workstation (referred to as the client) and submit
simulations from the primary workstation to run on these remote computers. In addition to running remote simulations, these
remote computers retain their ability to run FLOW-3D as a client. The following sections will discuss how to set up Remote
Servers and Clients.

3.1.1 Terminology and Requirements

The remote solving setup uses several programs on multiple machines, so it helps to define what each program is and the
terminology that will be used beforehand. A list of the programs and terms is given below:

• Server: The remote machine where the simulation will be run.

• Client: The local machine where the setup is done. Simulations can also be run on this machine.

• FLOW-3D Server Admin: This is a configuration program that is run on the server to configure RunnerServer
for remote solving.

• RunnerServer: This program interfaces between the FLOW-3D user interface and SolverRunner. An instance
of this runs on both the client (for running local simulations) and the server (for running remote simulations).

• SolverRunner: This program interfaces between RunnerServer and the solver, hydr3d.

Additionally, there are two main requirements for the remote solving feature:

1. All of the clients and servers must have a working installation of FLOW-3D before the remote setup can begin (see
Procedure for more information on installing FLOW-3D ).

2. SolverRunner, RunnerServer, and FLOW-3D all communicate using sockets, so certain ports will need to be
opened in the firewall.

3.1.2 Remote Servers

1. On Windows, FLOW-3D Server Admin will automatically elevate its privileges. On Linux systems, FLOW-3D
Server Admin can be started by the root user or other users.

• On Windows, there is only one database file, so FLOW-3D Server Admin must be run by only one user.

• As the FLOW-3D server is restarted when the machine is rebooted, the user account to run the server requires Log
on as a Service rights.

Use secpol.msc from the Command Prompt or Start Menu to open the Security Policy snap-in. Select
Local Policies -> User Rights Assignment and double-click Log on as a Service
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Click the Add User or Group button and add the desired account.

3.1. Remote Solving Setup 41



FLOW-3D User Manual, Release 1.0.0

More information about allowing Log on as a Service rights is available from Microsoft

2. Start the remote server: FLOW-3D Server Admin is an executable that configures and controls the
RunnerServer for use as a remote server. It is accessed differently depending on the OS:

• Windows: Use the FLOW-3D Server Admin icon in the FLOW-3D v12.0 Program Group in the Windows
Start Menu. This is a shortcut to a batch file in the local folder of the FLOW-3D installation directory (e.g.,
c:\flow3d\v12.0\local\ServerAdmin.bat). A User Account Control dialog will be displayed asking
for these privileges. The executable is digitally signed by Flow Science.

• Linux: Run the script ServerAdmin.sh (or ServerAdmin.csh) located in the local folder of the FLOW-
3D installation directory (e.g., /opt/flow3d/v12.0/local/ServerAdmin.sh)

3. Server configuration : Define how the server will communicate with clients.

• The server configuration settings for RunnerServer are accessed on File→Server Configuration menu.

• Server Name: The Server Name field. provides a way for the server administrator to name the server for tracking
purposes.

• IP address: The IP address specified here is the IP address of the server machine. This field will automatically be
populated with possible entries; select the one that is appropriate for your network.

• Server Port Number: This is the port through which FLOW-3D on the client will communicate with
RunnerServer on the remote machine. This port must be accessible through the firewall.
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• SolverRunner Minimum / Maximum Port Number: Each time RunnerServer receives a job to run, it will spawn
a new instance of SolverRunner to run the solver. Each instance of SolverRunner communicates simulation
status information with the FLOW-3D user interface using a different port, so these fields specify the range of
ports that may be used for communication between FLOW-3D and each SolverRunner. This range of ports
must be open for communication through the firewall. The number of open ports is recommended to be equal to
or greater than the number of solver tokens that are available. On Linux, when using the iptables firewall, a
command similar to iptables -A INPUT -p tcp --dport 59150:59200 -j ACCEPT may be used
to open the ports.

4. Configure user authentication settings: Give users access to run simulations on this server.

• User authentication settings are accessed on the File→User Registration menu.

• Add: Adds a new user to the authenticated user list.

– Full Name: The name of the user (for the administrator’s tracking purposes)

– User ID: This is the username that will be used to authenticate the user when a client attempts to connect to the
server.

– Password: The password associated with the user ID for authentication

– Confirm Password: Re-enter the password to avoid typographical errors

– Email Address: The email address of the user. The administrator can send setup information to this address.

– Phone Number: The phone number of the user (for the administrator’s tracking purposes)

– Home Directory: The directory on the server where the user’s files are to be written before being transferred to
the client.

• Edit: Edits the selected user’s account settings.

• Delete: Deletes the selected user’s account.

• Email: Provided for the administrator to send an email to one or more of the registered clients for disk management,
maintenance issues, etc. When the administrator adds a new user during the remote server setup, the software
automatically generates an email message with the user ID, password, IP address and server port number to the
user. The administrator is given the chance to modify the message if desired and then send it. The same also occurs
if any of those fields are modified when the Edit button is selected where the email message specifically references
the change.

Note: The first time FLOW-3D Server Admin is run it will search for any existing user settings (from a previous
version of FLOW-3D ) and give an option to import them.

5. Start the remote server: Choose File→Start Server to start RunnerServer, allowing client machines to connect and
submit jobs. When the server is running, this automatically changes to Stop Server. The server can also be activated and
deactivated by toggling the icon of a running person.

Once RunnerServer is configured and running on the server, clients may begin submitting jobs to the server. When a job
completes, the results files are compressed, encrypted, and copied back to the client machine where they are decrypted and
uncompressed. The results files are then automatically deleted from the server.

If necessary, the server administrator can also kill running jobs by selecting one or more simulations and choosing the Kill
Selected Job button. If the administrator kills a running job from the server, the simulation is aborted and the results files are
not saved. This is intended as a last resort option for stopping a running simulation; terminating from the client is preferred
as the results will be saved and transferred to the client.

Note:
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• One instance of FLOW-3D Server Admin supports multiple client users.

• Any changes made to the server settings in FLOW-3D Server Admin do not take effect until RunnerServer is
restarted.

• The remote server is not intended to run remote simulations and local simulations simultaneously.

• The remote server cannot be stopped while simulations are running.

• It is not possible to remove a paused simulation from the server.

• The client and server will only communicate if they have the same GUI and solver version.

• Results files can take a significant amount of time to transfer from the remote server to the client machine.

• The GUI on the client machine may slow down while a results file is being transferred from the remote server.

3.1.3 Clients

Once the remote server setup is complete (see Remote Servers), client machines can be configured to use this server for
remote solving. When adding a new remote server on a client machine, the relevant setup information is entered in the
Preferences→Remote Simulation Preferences→Remote Server Registration dialog:

• Server name: the name of the server machine

• IP address: the IP address of the server machine

• Port Number: the port on the server machine through which RunnerServer communicates with external programs.

• User ID: the user ID (for authentication purposes)

• Password: the password associated with the user ID (for authentication purposes)

Existing remote servers can be edited or deleted using the respective buttons. After registration, the available remote servers
will be listed in the queue and in the menu when submitting jobs to preprocess or run. As with any program running on a
network, there are some potential issues that may occur:

• If a remote server disconnects it may be reconnected by right-clicking on the disconnected remote server in the queue
(shown in red) and choosing Try reconnecting to remote server.

• If the file upload fails when submitting a job, a simulation can be removed from the queue by right-clicking on the
simulation and choosing Remove from queue.

• If the results file fails to transmit (e.g., due to a connectivity problem) the results file must be manually retrieved from the
server.

The Preferences→Remote Simulation Preferences→Automatically download results preference controls whether the results
are automatically or manually downloaded from the server when the simulation completes. If this preference is unchecked,

the simulation will remain in the queue until the user clicks on the download button ( ) or removes the simulation from the

queue using the right- click menu. The results can only be downloaded after the download status icon ( ) is shown next to
the simulation in the queue. Alternatively, the Preferences→Remote Simulation Preferences→Leave Results on Remote Servers
preference can be enabled to leave the results on the remote machine instead of downloading them. In that case a small icon of

a cloud (like ) will be displayed in the Portfolio to indicate that the results exist remotely. The results can be downloaded
from the server to the client by right-clicking on the simulation in the Portfolio and choosing Sync Results.

Note:

• The client and server will only communicate if they have the same GUI and solver version.
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• Results files can take a significant amount of time to transfer from the remote server to the client machine.

• The GUI on the client machine may slow down while a results file is being transferred from the remote server.

3.2 Preferences

The Preferences drop-down menu allows users to control default settings for file locations, remote simulation, etc. A brief
description of the options is given below:

Visuals

• Sub-tab Color: This option allows sub-tabs, e.g. Meshing & Geometry to be colored differently from the main tabs for
easy identification.

• Use default screen resolution for snapshots: Allows for user-defined screenshot resolutions.

• Set Font for Simulation Output Text and General/Notes: Choose the display font for the output text and the notes.

• Show Simulation Information in Simulation Manager: Shows/hides the diagnostic text at the bottom of the Simulation
Manager.

File management

• Default Workspace Location: This allows the user to choose the default location where workspaces will be created.

• Add Existing Simulation starts in Workspace: This determines whether the Add Existing Simulation dialog opens in the
folder containing the currently selected workspace or not.

• Project Creation/Copy Options: This controls the file system structure for simulations and what is copied between simu-
lations.

• Autosave Options: Controls how frequently the simulation setup is saved automatically.

• Auto-raise Project/Results File Dialog: Prompt user to load a new results file if the simulation that is selected on the
Simulation Manager does not match the results file that is open on the Analyze tab.

• Load Simulations When Opening Workspace: Option to automatically load simulations into memory when a workspace
is opened.

Simulation settings

• Default Version Options: This allows the user to choose the default Version Options for the local machine and all remote
machines. Run With Available provides permission to the solver to run with less core/license resources than requested.
This is useful when there are other simulations running and or core resources are limited to less than requested number
of processors.

• Simulation Pre-Check Tolerance: This is the default tolerance for the Material Properties in the Simulation Pre-check.

• Set Default Selected Parameters for Selected Data in Output: Choose which variables will be output by default in the
Selected Data.

• Model Setup: The visuals of the widgets in Model Setup can be modified here to show or hide labels on the process
toolbar. Additionally, the user saved preferences of the Model Setup layout can be reset to the default configuration.
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• Simulation Default Settings: This allows the user to define the standard units and pressure reference applied by default
to new simulations. If custom units are desired, those can be selected here. Custom units cannot be displayed in post
processing on the scale in the Display tab.

Communications

• Remote Simulation Preferences: This gives access to the Remote Solving Setup controls, including those for Remote
Server Registration and leaving the results on the remote machine.

• Local Queue Communications Settings: This allows for the configuration of the local queue settings, including the port
number.

Databases

• Location: This allows users to add and remove each Materials Database. At the first launch of FLOW-3D after instal-
lation, a prompt will include selection of any preexisting Materials Database locations to include. The Location menu
provides user control for each database that is stored at a local or network location.

FLOW-3D and TruVOF are registered trademarks in the USA and other countries.
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